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What are plugins and what are they good for?

In Sibelius, plug-ins are extra features created using a programming language called Manuscript. Sibelius ships
with about 150 plug-ins. These plug-ins are documented in the Sibelius Reference. Plug-ins can do many of the
same things that built-in Sibelius commands do.

Plugins mostly do not work when you are in Note Edit mode or when playing back. I tend to think of them as
“post-processing” for material you have already added to a score. When a plugin dialog is visible, nothing else
can happen in the score.

One other important point: if you use a plugin to change elements of a score, it only changes what is there at
the moment. If you ran a plugin to change all sharps to flats, and later added more sharp notes, those will not
be changed unless you run the plugin again.

In Sibelius 7 and later, several commands on the Ribbon (Home > Bars > Split and Note Input > Arrange
>Reduce, for example) are actually plug-ins.
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Shipping, downloadable, and custom plugins

e Sibelius comes with about 150 Shipping plugins pre-installed, so you just need to find where they are
and run them.

e There are also about 450 free downloadable plugins, which have been donated by volunteers, and are
published by Sibelius on their Plugin Download Page. These need to be installed before being used,
using File>Plug-ins>Install Plug-ins.

e There are a smaller number of plug-ins for sale that you can install on your machine, or you can get
someone to write a custom plugin for you, or you can write your own plugins, using the ManuScript
language that Sibelius provides. These have to be installed in a more laborious manner, using these
instructions (which are somewhat out-of-date) or by installing and running the plugin Install New

Plugin.
Examples of plugins

e The shipping Transformations plugins can be found on the Note Input tab of the Ribbon. They are

mostly designed to be helpful to composers. They include:
o Retrograde

Invert

Double Note Values

Halve Note Values

Augment Intervals

Diminish Intervals

Pitch Mapping

Randomize Pitches

Rotate Pitches

Rotate Rhythms

Rotate Rhythms and Pitches

Shuffle Pitches

Transform Scale

O 0O O OO OO0OO0OO0O OO0 O

e The Batch Processing plug-in category has a mix of shipping and downloadable plugins. These
mostly process folders of scores or other files and act on all the files at once. Some examples of Batch
Processing plugins are:

o Batch Transpose

Calculate Statistics

Convert Folder of MIDI Files

Convert Folder of MusicXML Files

Convert Folder of Scores to Earlier Sibelius Version

Convert Folder of Scores to MIDI

Convert Folder of Scores to MusicXML

Export Each Instrument as MIDI

Export Each Staff as Audio

Export Folder of Scores As PDF

Export Folder of Scores In Multiple Formats

Extract Parts From Folder of Scores

Import House Style into Folder of Scores

Rehearsal Recordings

O O OO O0OO0OO0OO0OO0OO0OO0OO0OO0


https://www.sibelius.com/download/plugins/index.html?help=install
https://www.sibelius.com/download/plugins/index.html?help=install
https://www.sibelius.com/download/plugins/index.html?help=install
http://www.sibelius.com/download/plugins/index.html?plugin=298
http://www.sibelius.com/download/plugins/index.html?plugin=298

Why are these not part of Sibelius itself?

Sibelius decided fairly early on that they could separate some commands from the main code base, and work on
them independently, so they did not affect the schedule of the main program. They probably also wanted to
create some useful plugins to encourage other people to write them, since they were providing Sibelius users
with a programming language and plugin editor for free.

Originally all the shipping plugins were written by Sibelius, but they later found outside programmers to write
some of them. In addition, if users wanted to write useful plugins and make them available for other users for
free, Sibelius would vet them, and then publish them on their Plugin Download Page. Prior to Sibelius 7.5,
every release of Sibelius usually included a handful of new shipping plugins.

New user-provided downloadable plugins have been added, and are still being added, to the plugin download
page.

How do I find out which plugins are available, and what they do?

Shipping plugins are already installed when you first start Sibelius. They are described in the Sibelius
Reference in Section 2.13 — Plug-ins. You can search for the plugins by name in that PDF file. Most of the
time that section will give a description of the plugin and tell you which menu to use to run the plugins.

There is no official documentation for downloadable plugins, other than what they provide. Such plugins will
usually have a description on their main dialog, and may also have a Help dialog and can include a PDF file
when they are installed. Their entry in the plugin download page usually has a general description plus an
update history.

When I am looking for a plugin. I usually google something like “Sibelius <plugin name>”, and something will
probably come up. You could also ask a question on one of the Sibelius online forums.

There have been a lot of blog posts, especially on Scoring Notes and Of Note, describing specific plugins, and
when I publish new plugins I will usually post a description of the plugin to the Sibelius tech support forum and
the Facebook groups Avid Sibelius Users and Sibelius Power Users.

I have links to a number of documents about plugins on the Sibelius page of my web site.

The Big List of Plugins™

Philip Rothman of NYC Music Services also maintains a list of downloadable plugins, sorted alphabetically by
name, and this can be very helpful when trying to find a plugin you want to install.

You can sort the columns by name, category, Sibelius version, or author, but the big gain is the Search
button. You can type any part of a plugin name, and you will see any plugins that match what you typed,
anywhere in the list. This will show you the category, which you can use to find the plugin when you go to
install it. The list is also a great way to browse for plugins available on a given topic.

Here is an example list of plugins that relate to harps:


https://www.sibelius.com/download/plugins/index.html
https://www.scoringnotes.com/
https://www.rpmseattle.com/of_note/
https://www.sibelius.com/cgi-bin/helpcenter/chat/chat.pl?groupid=3
https://bobzawalich.com/sibelius/
https://www.nycmusicservices.com/musicresources/#sibelius-plug-ins

Shuwl;ﬁall v entries Search: harp

Sibelius
Plug-in Name ¥ Author ¥ Category = . =

version
Add Harp Pedal Diagrams Meil Sands Harp G+
Alternate Harp Pedaling Bob Zawalich Harp G+
Change Text Accidental Size Bob Zawalich Harp G+
Color Harp Strings Bob Zawalich Harp 5+
Filter Harp Pedal Changes Bob Zawalich Harp G+
Filter Harp Pedal Diagrams Bob Zawalich Harp 5+
Harp Arpeggio lan Cugley Harp 5+
Harp Diagram from Tuning Bob Zawalich Harp G+
Harp Gliss lan Cugley Harp 5+
Harp Gliss and Octave Notes Bob Zawalich Harp G+
Harp Gliss From Pedal Diagram Bob Zawalich Harp 5+
Harp Gliss Pitches Bob Zawalich Harp G+
Harp Gliss Playback Bob Zawalich Harp G+
Label Harp Diagrams Bob Zawalich Harp 5+

If you click on a plugin name, the link will take you to the Sibelius Plugin Download Page entry for that
plugin, where you can see the plugin description and update history, and even download the zip file should you
so desire.



Alternate Harp Pedaling

Version 01.09.00
Added 01 Jan 2010 (last updated 07 Mar 2014)

For use with Sibelius 6, Sibelius 7.1, Sibelius 7.5, Sibelius 8 x, Sibelius 18 x,
Sibelius 19.x, Sibelius 20.x and Sibelius 21.x

Given some entered note pitch names, the plugin will make a list of all the harp
pedalings that include these pitches.

The pitches must be defined using CAPITAL letters C D E F G A B for pitches, in
any order, with b or # for accidentals, and optional X for placeholder pitches.
Each pitch must be separated by at least 1 space. There can be no duplicate
pitch letter names, and no more than 7 pitches. Double accidentals are not
allowed.

The results will be put in a listbox. If no pitch can be found for a harp string, an X
will be displayed.

Choosing an entry in the list moves a copy to an edit box from which you may
copy the tuning text. The text following the tuning (font name and MLNO
characters) is text for a pedal diagram. Paste this into a text item in a score to
display as a pedal diagram.

+ Download AlternateHarpPedaling.zip (9K, downloaded 25595 times)
Plug-in wriften by Bob Zawalich.
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Accidentals (9) »
Arrange (2) »

Analysis (2) »

Batch Processing (21) »
Color (12) »
Composing Tools (41) »
Layout (45) »

Menus and shortcuts (4) »
Notes and rests (70) »
Other (42) »

Playback (23) »
Proof-reading (6) »
Text (92) »

Navigation (13) »

Filter and Find (47) »
Chord Symbols (11) »
Note Input (4) »

Lines (16) »

Simplify Notation (1) »
Focus On Staves (2) »
Comments (2) »

Harp (14) »
Transformations (7) »
Hitpoints (3) »

Guitar (6) »

Banjo (3) »

Selection (7) »
Developers' Tools (23) »
Engravers' Tools (35) »
Tuplets (4) »
Sight-impaired (8) »

Typically, in Sibelius 7 or later at least, you will not want to download the zip file, but would instead install the
plugin in Sibelius using File>Plug-ins>Install Plug-ins.

Scoring Notes has a post about this list. Thanks to Philip Rothman for hosting and maintaining it.

I keep a shortcut to this list in all my browsers.


https://www.scoringnotes.com/tips/the-big-list-of-plug-ins/

Installing downloadable plugins (Sibelius 7 and later)

You can install plugins from the Sibelius Plugin Download Page using the plugin installer at File > Plug-ins
>Install Plug-ins. Recent versions of Sibelius Ultimate (2019.4 or later) have a Find box where you can type
in the plugin name or a part of the name, and find matching plugins. In earlier versions of Sibelius 7 or later,
you would need to know the category of the plugin to avoid having to search through 500-odd plugins, and that
was one of the motivations for creating the list of downloadable plugins.

Install Plug-ins
Show: | All plug-ins ~ |stem | Find
Plug-ins P Description

Add Articulations to Notes

Add Bar Rests In Empty Voices
Add Chord Notes Below Melody
Add Interval

Add Interval Diatonic 10th

Add Pipe Omaments

Add Slash Nateheads for Parts for Si
Adjust Stem Lengths
Arpeggiate Chords

Beamed Note Groups
Combine Rests Empty Voices
Consclidate Ossia Staves

Adjust the stem lengths of selected notes by adding an offset (in units of
spaces) to the current or default Stem length of these notes. Unlike the
Inspector, a positive value increases the stem length, and a negative value
decreases it, regardless of stem direction.

Setting the default length to O will reset the length to the default length.

Updated 19 April 2021, Added ability to hide dialog.

Plug-in written by Bob Zawalich

Count Notes

Create N by M Tuplet

Create Trailing Pseudo-Grace Notes
Dangling Ties To Slurs

Delete Music Only

Delete Rests Empty Voices
Delete top/bottom notes
Divide Durations

Dot Undot Rhythm

Dotted Minim Rests

Crum Cues

Fill Selection With Slash Notes
Fill With Slurs

Fill With Tied Notes

Find Irreqular And Misfilled Bars ha

——
Location: | Other W Install

[ other:

Close

Installing custom and user-written plugins (and plugins prior to Sibelius 7)

The plugin installer was a game-changer for using plugins. Prior to that you had to find the plugin zip file on
the download page, unzip it, and then copy the resulting plg files to an appropriate plugin folder.

These instructions, though detailed and well intentioned, were a hardship for many people, and this limited the
use of downloadable plugins. I wrote the plugin Install New Plugin to make the process easier, but there was
the problem that you needed to install Install New Plugin before you could run it, and the chicken and the
egg were kind of looking at each other in confusion. Now in Sibelius 7 or later you can use the plugin installer to
install Install New Plugin, which you can use to install the plugins you bought, and so on.

If you are using a version of Sibelius prior to version 7, or write your own plugin, or buy plugins that do not
provide their own installer, you will need to copy the file to a plugin subfolder or use Install New Plugin.

We old-timers did that for a long time, but if you can avoid it, I recommend doing so. The plugin installer is
your friend.


https://www.nycmusicservices.com/musicresources/#sibelius-plug-ins
https://www.sibelius.com/download/plugins/index.html?help=install
https://www.sibelius.com/download/plugins/index.html?plugin=298

Duplicate Plugins

Duplicate plugins, which are plugins with the same “name without path” but different full paths are a problem
in Sibelius. See Eliminating Duplicate Plugins in Sibelius for details.

Run Plugin By Name and My Plugins will warn you if there are duplicate plugins the first time they run in
a Sibelius session, and will tell you which copy it thinks Sibelius will run, but if you have duplicate plugins you
are in an unstable situation and you cannot really know if the plugin you want to run will be run. This can be
really bad, or harmless (if they are identical copies of the same plugin), but you don’t really know which.

If you encounter duplicate plugins you should stop and figure out which plugin is the correct one (usually the
most recent one), and delete the duplicate files. Proceed at your own risk.

Running Plugins

Running Sibelius plugins requires you to either know the menu that contains your desired plugin, to assign
shortcuts to the plugins you use, or to use plugins that run other plugins.

1. You can run plug-ins from the Plug-ins menu in Sibelius 6 and earlier, or from plug-in galleries present in
several of the tabs in the Sibelius 7+ Ribbon (Home, Note Input, Text, Play, and Review).

Here is an example of one such menu, on the Note Input tab of the Ribbon (screenshot is from Sibelius
Ultimate 2021.2). There are several submenus:

Y

Plug-ins

~ Al
Accidentals
Composing Tools
Motes and Rests
Simplify Netation
Tuplets

— T e e e

=

Here are the plugins contained on the Composing Tools sub-menu


https://www.rpmseattle.com/of_note/eliminating-duplicate-plugins-in-sibelius/

EEE E‘;..% %—-# Mote Values % 2 ﬁ

J | Double

Arrange Explode Reduce Retrograde Invert More
o 2 Halve = .
| Arrange Fl | Transformations Composing Tools ¥

Composing Tools
12-Tone Matrix
Composing Tools Plug-in 12-Tone Matrix2
menu in the Note Input Add Drum Pattern
Ribbon tab Add Hit Point Staff
Add Simple Click Track

Add Simple Harmony

1T
1T
k]
17w

Apply Key Signature To Selec
f Copy Signatures to New Sco
Delate Pickup Bar

Disguise Score

Draw Free Rhythm Barline
Exchange Staff Contents
Explode

L)
[TTe
T
Bk

f Explode Specific Staves
Explode Staff To Parts

Find Intervals From Keys
Find Range Plus 2
Find and Replace Rhythm

Fit Selection To Time

Insert Mote or Rest

Invert Chords

Invert Chords Down

f Reduce

I would say that finding the appropriate menu, and then finding the plugin on the appropriate submenu is not
a very efficient way to access a plugin if you need to use that plugin often.

2. In Sibelius Ultimate 2021.2 or later, you can type in a plugin name to the Command Search box at the top
right end of the Ribbon, and pretty quickly find and run a plugin. It sometimes takes a while to figure out
how to best write your search string.

Command
Search box

| &) export folder] ||

1| Export Folder of Scores As PDF

it Home » Plug-ins » Plug-ins

Batch Processing » Export Folder of Scores As PDF

Extract Parts From Folder of Scores
Home » Plug-ins » Plug-ins

Batch Processing » Extract Parts From Folder of Sco

some

matching Import House Style into Folder of Scores
plugin names Home » Plug-ins » Plug-ins

Batch Processing  ® Import House Style into Folder

Run Plugin On Folder Of Scores
Home » Plug-ins » Plug-ins
| Batch Processing ® Run Plugin On Folder Of Scores
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3. Assign a shortcut to a plugin

Go to File>Preferences>Keyboard shortcuts>Plug-ins, select a plugin and assign it a keyboard
shortcut. Now when you type the shortcut the plugin will run.

The only real problem with this is that there are a fairly small number of shortcut keys available, and you need
to remember them.

4. Use other plugins to organize and run your installed plugins. These include
¢ Run Plugin By Name
e My Plugins
¢ Fixed Plug-in Shortcuts

Shortcut strategies for plugins

Available keyboard shortcuts are in short supply and Sibelius does not make it easy to find out if a shortcut is
available.

About the only way to tell is a shortcut is available on your machine is to go into
File>Preferences>Keyboard shortcuts and try to add a shortcut to a command. If that shortcut is
assigned to something already, it will tell you what it is assigned to, and you can either decide to override the
assignment and put it on your command, or choose a different shortcut until you find one that is available.

I run almost all my plugins through the plugins Run Plugin by Name and Run Last Named Plugin, so I
assign easy shortcuts to those 2 plugins.

I decided at some point that I would take over the function keys F3 to F12 for plugin use, so I lost the normal
mappings for those commands. I assign F8 to Run Plugins By Name and F7 to Run Last Named Plugin.
F9 — 12 and F6 I have assigned to other plugins I use all the time, and F3, 4, and 5 are my “temporary critical’
plugins, which I might need a lot for a specific project.

Run Plugins By Name keeps the last 20 plugin I ran at the top of its list, providing a recent working set of
plugins I have used, and these are easy to find. My Plugins lets you specify a set of plugins to run that do not
change unless you specifically change them, so these are effectively another set of plugin shortcuts. My
Plugins limits you to a set of 36 plugins, with internal shortcuts 0 — 9 and A — Z. My guess is that for many
people this would be a good size of a working set of plugins in regular use.

My Plugins has a companion plugin Rerun My Plugins, and Run Command Macro has Rerun
Command Macro, and Fixed Keyboard Shortcuts has the companion plugin Run Previous Plug-in
(for use with Fixed Plug-in Shortcuts).If you use any of these main plugin to run your plugins, I strongly
suggest assigning keyboard shortcuts to both the main plugin and its companion.

The exact mapping does not matter, but having a consistent scheme will make it easier to remember and
manage you shortcuts.

Run plugins without showing dialogs

If you need to run the same plugin multiple times, it can be annoying to have a large dialog show up each time,
just to have you press OK. Some plugins will allow you to hide a plugin’s dialog after the first time it appears in
a session (I find it is best to have to see the dialog at least once per session so you can review the dialog settings,
so most plugins that I have written that allow you to hide dialogs will always show the dialog the first time a
plugin is run in a Sibelius session).



If the plugin supports hiding its dialog there will usually be a “Do not show dialog” checkbox in the lower left
corner of the dialog.

Bracket Text - Version 01.93.00 - by Bob Zawalich

This plug-in puts brackets or parentheses (or any chosen character(s)) arcund selected text objects, or groups of text ohjects. It is especially useful
for bold expressions (dynamics) entered with the ctrl or cmnd key, since those involve a font or character style change, or for metronome marks
that use noteheads.

Extra formatting options can be set with the Engraving Rules... button.

Dialog settings are saved across Sibelius sessions. Lyrics are not processed.

When processing Expression text style only, it will process any user-defined styles derived from Expression text.

Open bracket Close bracket {® Process all text styles

() Process all styles except Expression

@® () around each text object () Pracess only Expression text style

(O ( before first text object in group, ) after last only Engraving Rules...
[] Do not show dialog (this Sibelius session) Cancel

There are some other mechanisms for hiding dialogs, but this is the most commone one. In most cases, even
when a dialog is hidden it can be made to appear by running a plugin with no selection in the score.

Using plugins to run other plugins

Run Plugins By Name

There are a number of ways to make the actual running of plugins simpler. I use Run Plugins By Name to
run nearly all my other plugins.

Install Run Plugins By Name (category Other). This will install an additional plugin, Run Last Named
Plugin, as well.

I assign easy-to-use shortcuts for both these plugins because I use them all the time. Since I don’t use some of
the function keys as Sibelius intended, I use F8 for Run Plugins By Name, and F7 for Run Last Named
Plugin, but any convenient shortcut key will do.

Here is what the dialog for Run Plugins By Name looks like:
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This plug-in will run the selected plugin. Plugins recently run by this plugin (but not those run
directly) appear first in the list, in the erder in which they were run, followed by other available

plugins, which are sorted by name.

Select or find a name in the list, then click or Tab te the Run plugin button.

Find plugin

Run plugin

Plugins to run

Plugin Descriptions
List Plugins
Invert Chords
Install New Plugin
Export Manuscript Paper Unchanged
All Symbuols Labeled

Find and Replace Text

Create Insert Symbol Plugin

Insert One Symbol

Identify Selected Objects

Identify Selected Symbols

Find Symbal

Export Audio Score And Parts

There It Is!

Browse Selected Objects

What Is Where

Calculate Statistics

Color Enharmonic Pitches

Apply Mamed Color
| Swap Or Replace Text Styles

Use "Find plugin" as default button

The last

20 plugins
| have run

12-Tone Matrix

About Dolet 6 for Sibelius

Add Accidentals to All Motes

Add Accidentals to All Notes Multi Select
Add Accidentals to All Sharp and Flat Notes
Add Articulations To Motes

Add Articulations To 5elected Motes

The rest of
my installed
plugins, in

alphabetical
order

Add Bar Before Special Barline
Add Bar Number Changes For Rehearsal Marks
Add Bar Rests In Empty Voices

Max number of recent plugins: Cancel

] Run Stopwatch by Bob Zawalich

First of all, there is a list of all the plugins installed on your machine, both shipping and user installed. The first
20 plugins in the list (as determined by the Max number of recent plugins checkbox) are the 20 most recent
plugins, in the order in which they were run.

After those plugins, all the rest of the plugins are listed in alphabetical order by name (normally the name that
appears on a plugin menu). I don’t need to care where they are installed on my machine, or which menu they
live in.

To run a plugin, you can type any part of a plugin name in the Find plugin edit box, then type Enter (which
will activate the Find plugin button) until you have the plugin you want selected in the list.

Then tab (once or twice as needed) to the Run plugin button, type Enter, and the dialog will close and the
plugin will run.

Running the same plugin again
If you want to run the same plugin again, you can repeat the above procedure (and the plugin you just ran will
be at the top of the list) or you can run Run Last Named Plugin (you assigned a shortcut to it, didn’t you?),

which will run that plugin without you needing to choose it. This works great if you are running a single plugin
several times, and you don’t need to give it its own shortcut.

More details on using Run Plugins By Name are available here.
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https://bobzawalich.com/wp-content/uploads/2021/07/Using-The-Plugin-Run-Plugins-By-Name.pdf

My Plugins

My Plugins is a plugin in the Sight-Impaired category, originally designed to make it easier for sight-impaired
users to run plugins.

It lets you add up to 35 plugins into a list, each of which is given a numeric (1 — 9) or alphabetical (A —Z)
prefix that acts as a shortcut, If you assign a keyboard shortcut to My Plugins you can run any of the plugins
in the list by typing the first letter or number for the plugin you want, and then pressing Enter.

Unlike Run Plugin By Name, you have to use the Customize option to add the plugins into the list, but
once you do that, the shortcuts will be fixed until you change them yourself, which makes it easier to memorize
shortcuts for plugins you use often.

My Plugins

Plugins to run Run the plug-in selected in the list. Add

0 - (do not use | plugins or rearder the list in Customize.

2 - Combine Tied Notes and Rests Type the shortcut (the first number or letter ina
3 - Double Note Values list entry), or select the entry with the mouse,

4 - Draw Free Rhythm Barline then click Run or type Enter.

5 - Find and Replace Text

6 - Halve Note Values Shortcuts that are letters can be entered in

7 - Harmonics Playback either lower case or upper case (a or A give the
& - Realize Chord Symbols same result).

9 - Rehearsal Recordings

A - Renotate Performance "Run plugin if list box changes™ runs a plugin if
B - Scales and Arpeggics you click, arrow, or type in the list box. It

C - Simplify Accidentals requires Sibelius 7.1.3 or later.

D - What Is Where
The first list box entry is a placeholder to
support the “"Run plugin if list box changes”
option. You will need to select a different entry
to run a plugin.

[] Run plugin if list box changes

by Bob Zawalich Version 02.12.01
Customize...
Cancel Run plugin

Running the same plugin again
If you want to run the same plugin again, you can run Rerun My Plugins, another candidate for a shortcut.

More details on using My Plugins are available here.
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Fixed Plug-in Shortcuts

This is a plugin written by Hans-Christoph Wirth to solve a problem in earlier version of Sibelius where
shortcuts to plugins were not stable. It can still be useful in current versions of Sibelius Ultimate. It is similar to
My Plugins in that you add entries to the list of plugins, and the plugins retain their shortcuts.

It is described in the plug-in list as “Fixed Plug-in Shortcuts” but the plugin refers to itself as “Fixed
Shortcuts”. It has some interesting features that you might want to look into.

Keymap: B (Bobs Tools)

Press A.Z to select a plug-in or navigate down the hierarchy.
Press * to navigate up or press / to start over from the top.

<< Toi

- list of plugins and keymaps -

Split Bar

N-<><E{C—|mmg'uozgl—KL——ImﬂmUnmp

Enter config mode... Close Up/Down

Opticns...

Fixed Shortcuts Release 2.3 (c) by Hans-Christoph Wirth

Running the same plugin again

If you want to run the same plugin again, you can repeat the above procedure, or run the companion plugin,
Run Previous Plug-in (for use with Fixed Plug-in Shortcuts), written by Corwin Newall, that will run
the last plugin that was run by Fixed Shortcuts.

More details on using both Fixed Plug-In Shortcuts and Run Plugins By Name are available here.
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Writing your own plugins

You can do it! Sibelius provides a plugin editor and the ManuScript Language Reference for free (go to
File>Plug-ins to access these.)

Simple plugins can be useful and relatively easy. More complex ones have taken me several months to write.

I have some documents on writing plugins on my website. They are really just rough drafts, but they could be
useful. You can read though the ManuScript Reference and try things out, and you can actually open and look
at the code for any installed plugins.

Feel free to study the code, but be aware that it is copyrighted by its authors. Please treat it the way you would
treat a score by another composer, and do not copy code that is not marked as public domain without asking
permission.

In Sibelius Ultimate 2021.2 and later, Sibelius added Commands that can be run by plugins, and this makes
writing simple plugins considerably easier. I wrote a series of plugins, including Execute Commands, cmdutils,
and Run Command Macro that provide a development environment where you can set up sequences of
commands that you can run, or save as a macro file, or use to auto-generate a plugin that will execute the
sequence of commands.

I have a number of instructional documents, including several tutorials, on the Execute Commands Plugin
Documentation page of my website. There you can find the reference manual for the cmdutils plugin which is a
library of additional commands that I wrote to make macros easier and more powerful.

Where to look for information on plugins

I have links to a number of documents about plugins on the Sibelius page of my web site, including links to
many blog posts about plugins on Scoring Notes and Of Note.

You can ask questions about them on the Sibelius tech support forum and the Facebook groups Avid Sibelius
Users and Sibelius Power Users.

Composers will find useful tools in the Transformations, Composing Tools, and Engravers’ Tools
categories, but there are lots of plugins you will not use every day, but which will save you hours of work
sometime (see, for example Tie Extended Stable) . It can be useful to browse around.

Some Interesting Plugins

Here are some plugins you might want to have a look at. Many have links to blog posts or PDF documents
describing their use, and any shipping plugins (marked with a *) will have some explanation in the Sibelius
Reference.

12 Tone Matrix*

Add Harp Pedaling*

Add Pickup Bar

Apply Series

Apply Named Color

Bracket Text

Calculate Statistics

Clipboards

Combine Tied Notes And Rests*
Copy Double/Halve Note Values

Disguise Score

14


https://bobzawalich.com/writing-sibelius-plugins/
https://bobzawalich.com/execute-commands-plugin-documentation/
https://bobzawalich.com/execute-commands-plugin-documentation/
https://bobzawalich.com/wp-content/uploads/2021/06/The-cmdutils-library-in-Execute-Commands.pdf
https://bobzawalich.com/sibelius/
https://www.scoringnotes.com/
https://www.rpmseattle.com/of_note/
https://www.sibelius.com/cgi-bin/helpcenter/chat/chat.pl?groupid=3
https://www.scoringnotes.com/tips/the-tie-extended-stable-plug-in-for-sibelius/
https://makingthemostofnotationsoftware.blog/2017/11/08/adding-a-pick-up-bar-in-sibelius-and-finale-after-the-score-has-been-created/
http://www.sibelius.com/download/plugins/index.html?plugin=467
http://www.sibelius.com/download/plugins/index.html?plugin=14
https://www.scoringnotes.com/tips/calculate-statistics-in-a-sibelius-score/
https://www.scoringnotes.com/tips/using-the-clipboards-plug-in-in-sibelius/
https://www.scoringnotes.com/tips/new-plug-in-disguise-score/

Divide Durations*
Double/Halve Note Values*
Draw Free Rhythm Barline*
Edit Instrument Names
Exchange Staff Contents
Execute Commands

Export Audio With Count-In
Export Lyrics*

Export Selection As Score*
Fill With Tied Notes

Filters

Find and Replace Text*

Flip Selected Notes

Focus Families/Focus Sets
Go To

Harp Gliss Playback

Invert Chords

Lines Between Notes
Multirests and Empty Bars
Note Spacing

Open Selected Parts

Pitch Mapping/Transform Scale/Percussion Pitch Mapping*

Proof-Reading*

Rehearsal Recordings*
Resize Bars*

Respell Accidentals plugins*
Scale Notehead Sizes
Scordatura

Solfege

Tie Extended Stable

Tuplet Plugins*

Tuplets Over Barlines
Unfold Repeats

What Is Where*/There It Is

Good luck. Plugins can totally change the way you work with Sibelius. Have fun!
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https://bobzawalich.com/wp-content/uploads/2020/04/Divide-Durations-Plugin.pdf
https://www.scoringnotes.com/tutorials/format-text-in-the-edit-instrument-names-plug-in-for-sibelius/
https://www.scoringnotes.com/tips/swap-the-contents-of-two-staves/
file:///F:/Word%20Documents/Sibelius%20Plugins/Design%20and%20Analysis%20documents/execute-commands-plugin-documentation
https://www.scoringnotes.com/tips/add-a-count-in-to-your-exported-audio-tracks/
https://www.scoringnotes.com/tips/fill-with-tied-notes/
https://bobzawalich.com/wp-content/uploads/2019/06/Filtering-multiple-objects-at-once-with-the-Filter-With-Deselect-plugin.pdf
https://www.scoringnotes.com/tips/reliably-flip-beamed-groups-and-force-stem-direction-in-sibelius/
https://bobzawalich.com/wp-content/uploads/2020/08/The-Focus-Families-and-Focus-Sets-plugins.pdf
https://www.scoringnotes.com/tips/harp-glissando-and-arpeggio-playback-in-sibelius/
https://bobzawalich.com/wp-content/uploads/2018/09/The-Invert-Chords-Plugin.pdf
https://www.scoringnotes.com/tips/lines-between-notes-in-sibelius/
http://www.avidblogs.com/three-things-fixing-broken-multirests/
https://bobzawalich.com/wp-content/uploads/2018/08/The-Note-Spacing-Plugin-in-Sibelius-7.pdf
https://www.scoringnotes.com/tips/using-the-open-selected-parts-plug-in-in-sibelius/
https://www.rpmseattle.com/of_note/mapping-pitches-in-sibelius/
https://www.scoringnotes.com/tips/5-plug-ins-to-help-with-proof-reading/
https://www.scoringnotes.com/tips/create-rehearsal-recordings-in-seconds-with-new-plug-in/
https://www.sibelius.com/download/plugins/index.html?versionname=&category=1
https://bobzawalich.com/wp-content/uploads/2019/03/How-to-use-the-Scale-Notehead-Size-plugin-in-Sibelius.pdf
https://www.scoringnotes.com/tips/the-tie-extended-stable-plug-in-for-sibelius/
https://www.scoringnotes.com/tutorials/create-tuplets-over-a-barline-in-sibelius/
https://www.scoringnotes.com/tips/there-it-is/

